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INTRODUCTION 

Let's see,... YOH hqye your triangle and your ruler, your 
compass and ~rotractor, a #2 lead pencil and a ruling pen 
for the real.$t7;,ai¥~t,' lines. You have a variety of 
paintbrushes - #0 for fine lines and #15 for the fat (Jnes. 
Then, there's the .rub-on letters, and the India Ink for that 
real black black. Of course, you need tubes of paint in 
eve r y color of the rainbow, a duplication machine and 
plenty of paper. Now, hold it right there!! Pick all that up 
and put it away because you've got all that, plus a whole lot 
mort!, packed into The Graphics Studio. And just to make 
things really interesting, a couple of eye-dazzling .tricks 
a,re thrown in at no extra charge. With The Graphics 
Studio, you're equipped to take on an~' challenge. 

The Graphics Studio is more than a paint program, m 0 r e 
than a graphics editor. It is designed to be an extension of 
the creative process. We realize that each user will come to 
the Graphics Studio with a different level of expertise and 
have designed The Graphics Studio to support and enhance 
that knowledge. From a simple doodle to a complex image, 
The Graphics Studio performs with ease. 

The Graphics Studio lets you take any part of a picture and 
shrink it, expand it, rotate and flip it. Place it anywhere 
you want and add an automatic drop shadow with the touch 
of button. Zoom in for detail work, or instantly create a 
blended range of color, and cycle through them to create 
the feel of animation. Once you're finished, save it to disk, 
so you'll have it forever or print it out in blazing color. 
The Graphics Studio performs all of these functions and 
more with equal ease. To learn how to do it yourself, 
simply read on ... 



THE PHILOSOPHY OF THE GRAPHICS STUDIO 

The Graphics Studio can turn a computer into a visual 
playground where experimentation is the order of the day, 
anything goes, and everyone is a winner. The tools are 
built-in, and technique is reduced to pressing buttons and 
selecting icons. This uninhibiting environment, provides 
the user with the ideal opportunity to express his ideas, to 
draw. This is the motivating force behind The Graphic 
Stu d i 0' s design. While the program provides a d a z z lin g 
array of tools, the smooth user interface is perhaps its m 0 s t 
powerful feature. With it, complex operations are reduced 
to a simple point, click, and draw. 

THE TOOLS 

In most cases, the tools and features are represented by 
simple icons;' 'which are grouped according to a common 
application or purpose. For example, all the Drawing Tools 
are located, in the l upper right-hand side of the Upper 
Menu. The majority of the editing tools, such as Copy, 
Xcolor, Scale, Flip and Rotate, are located to the left. 
Featdi-es that" affect the size; shape, and color of the 
drawing tools 'are grouped together in the Lower Menu. 
Within . the space occupied by these menus, there are over 
60 drawing tools. Add in the additional features, and there 
are more than' 100 drawing options to choose from, all of 
which are convenient located within easy access of the 
Drawing Area. This doesn't seem possible considering how 
little information is present on the menu when it firs t 
appears. This is because a pop-out icon interface hides 
them out of sight until they are needed. Imagine how 
awkward the selection process would be if all the icons 
where placed end-to-end. It would greatly reduce the size 
of the working screen and place an unnecessary burden 
on the user when trying to find the correct tool to use. 
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THE SCREEN 

Even though the tools do not take up a lot of room, you may 
still want to remove the menus and work on the entire 
screen. The Graphics Studio lets you do this quickly and 
easily, glvmg you a larger view of the picture, while 
maintaining the ability to use the same drawing options 
that were active when the menu was present. 

If you prefer, a full page picture can be viewed qui c k 1 Y 
using the vertical scroll feature. Because you always see 
the full width of your picture, there is no need to move 
horizontally. This makes locating a particular area of the 
page a lot easier. Add to this an additional screen-sized 
clipboard, and you've got plenty of room to work with. 
Note: All the tools work on both the screens. 

As mentioned, with The Graphics Studio, the full width of 
the screen is always visible. This makes it easier to 
visualize how the parts of a picture are arranged, and 
eliminates the jumping around required by other pain t 
programs just to check an iterns' location. 

THE MENUS 

The menus in The Graphics Studio are unique. In the Mode 
menu, many of the items can be toggled on and off. When 
you select on of these items, the menu remains down. This 
alternative approach to pull-down menus allows you to 
turn a number of items on and off without having to pull 
the menu down again. 

The Graphics Studio is simple to use and easy to master. It 
starts out with the obvious and ends up providing the 
power to create complex designs. It even has a few secrets 
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hidden just below 
willing to scratch. 
yourself. 

the surface ready to use, if you're 
Good luck and by all means enjoy 

MANUAL ORGANIZATION 

This manual is organized into three chapters, a few quick 
appendixes and an index. The first chapter, "A Qui c k 
Overview", lays out the system requirements and tells you 
how to load the program. In addition, it gives a brief 
introduction to the elementary tools and features of The 
Graphics Studio. If you are new to graphics programs and 
computers, you'll want to start here. 

The second chapter, "Using the Graphics Studio", covers 
basic features such as rotation, copy, text, loading, saving, 
and printing. This is a good place to start if you are 
already familiar with graphics programs. 

The third chapter, "Advanced Features", covers the more 
complex items such as color cycling, blending colors, etc. 
Once you are familar with how The Graphics Studios basic 
features work, you'll want to look here to learn how to 
make the most of your investment. 

The Appendixes cover everything from running the 
Slideshow, to tips on making the best use of the Graphics 
Studio. 
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CHAPTER ONE: 
A QUICK OVERVIEW 

This chapter lays out the system requirements and tells 
you how to load the program. In addition. it gives an 
introduction to the elementary tools and features of The 
Graphics Studio, such as selecting colors from the 
palette. using brushes and line tools. erasing and saving 
your work. If you're new to computer graphics. use the 
exercises here to learn the basics. 

SYSTEM REQUIREMENTS 

The Graphics Studio requires an Apple IIGS with 768K or 
more, a monitor, one disk drive, a mouse and a few 
initialized (formatted) blank disks to save your work on. A 
printer, second disk drive or hard drive are additional 
options. 

BOOTING UP 

The Graphics Studio uses a "key-disk" system that allows 
you to make back-up copies of your Graphics Studio 
program disk, so you do not have to worry about wearing 
out the original disk. Make a copy of the disk now, before 
you begin using The Graphics Studio. Refer to your Apple 
IIGS documentation for instructions on copying a disk. 

One Drive Systems: Insert your cop y of The Graphics 
Studio disk in the disk drive and tum on your computer. A 
message will appear asking you to insert your original 
program disk. At this time, eject your copy and insert the 
Graphics Studio program disk. After the program loads and 
the disk drive stops spinning, eject the program disk and 
place it back in storage. Reinsert your copy in the dis k 
drive. 



A QUICK OVERVIEW, 

Two Drive Systems: Insert your copy of The Graphics 
Stu d i 0 disk in Drive 1 and the original program disk into 
Drive 2. Turn on your computer. After the program has 
loaded (be sure the drive has stopped spinning), you can 
eject the original disk from Drive 2 and put it away. 

Booting The Graphics Studio with your copy reduces the 
chance of damage to the original program disk. If you 
prefer, however, you can boot The Graphics Studio with 
the original disk and replace it with your copy once the 
program is loaded. 

Hard Drive: To run The Graphics Studio from your hard 
drive, first copy all the files, except PRO-DOS and the 
System' Folder, from the'Graphics Studio disk onto your 

.'- hard driv~:' When you startihe program from the hard 
drive you will be prompted to insert your original pro g ram 
disk. At this time, insert the Graphics Studio program disk 
into Drive 1. After the program loads and, the, i drive h:a s 
stopped spinning, eject the program disk and put it away. 

When The Graphics Studio has finished loading, the screen 
will appear as it does it Figure 1. The large area in the 
center of the screen is the "Drawing Area". This is where 
you ;will do your creating. The top line on the screen is the 
Status Line/Menu Bar. Its' functions are explained below. 
The row of tools below the Status Line/Menu Bar are in the 
U-pper Menu. The tools at the bottom of the screen are in 
the Lower Menu. The Menus and the Status Line/Menu Bar 
may be removed from (and returned to) the screen by 
holding down the Command key while clicking the mouse 
button, or by pressing the Command key and "D" 
simultaneously. 
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A QUICK OVERVIEW 

STATUS LINE/MENU BAR 

This area of the screen supports two functions depending 
on the location of the mouse. When the cursor is in the 
drawing area, the Status Line is visible. The Status· Lin e 
tells you which tool is currently active (For example, when 
you first boot-up you are in "Draw wIth brush 
(connected)" mode.). At all other times, the Menu Bar is 
visible. If you do not wish to use the Status Line function, 
you may turn it off by pulling down on "Options" and 
selecting "No Status Line". 

THE PALETTE 

The palette in the Lower Menu is composed of 16 default 
colors which have been selected from an available range 
of 4,096. Later on, you will learn how to change these 
colors. At the far left of the palette is the Color Status Box. 
The inner color (currently black) is the foreground color. 
This is the color that you would be using if you were to 
start painting. Select a new color to work with by 
positioning the mouse over the desired color in the palette 
and clicking on it. That color now appears in the 
foreground area of the Color Status Box. In addition to the 
colors in the palette, you may use any of the patterns as a 
foreground color. Go ahead and paint with a few different 
colors. First, select your color and position the cursor on 
the Drawing Area. . Then, hold down the mouse button 
while you move the mouse. It's that simple. 

The outer color (currently white) in the Color Status Box is 
the background color. To change this color, click on the 
background area of the Color Status Box. Then, click on the 
desired color in the palette. The selected color now appears 
in the background area of the Color Status Box. 
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A QUICK OVERVIEW 

Patterns 

ERASING YOUR WORK 

By now. you may be wondering how to erase. There are 
three ways. The first is to click on the word "Undo" in the 
Upper Menu. Undo basically "undoes" your last action. To 
see how it works. draw a line. then click on Undo. The line 
disappears. Click on Undo again and it reappears (Y 0 u 
have undone your undo.). 

To learn the second way of erasing. click on the eraser to 
the left of Undo. The eraser is now highlighted indicating 
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that it is the currently selected tool. Move· the arrow 
cursor down to the portion of the picture you wish to eras e. 
Press down on the mouse button and while continuing to 
hold it down, move the mouse down and to the right. You 
will see a box forming on-screen, This is your eraser. 
When the eraser is the size you want it to be, release the 
button. You now have an eraser that you can move around 
on the screen. Whenever you press the mouse button, 
anything within the boundary of the eraser dis a p pea r s 
and is replaced by the currently selected background 
color. If you hold down the mouse button while you move 
the mouse, you can clear the screen in big wipes. 

The third way of erasing, erases the entire screen at once. 
To erase the screen, go back to the Eraser icon and hold the 
mouse button down. Another icon, a trashcan, appears 
below the eraser. Move the cursor down to the trashcan 
and release the mouse button. The screen will now be 
erased using the solid background color currently 
displayed in the background section of the Color Status Box. 
If you erase the entire screen and then change your mind, 
just click on Undo. After you have used the trashcan, you 
may notice a slight delay the first time you start to draw 
again. This is because the Undo area is being cleared. 

THE DRAWING TOOLS 

The Graphics Studio includes a number of different built­
in drawing tools. The drawing tools are located in the four 
"pop-out" menus to the right of Undo. The first menu 
contains the tools for free-hand drawing; the second 
contains the tools for "line drawing". Next to the Line­
Draw menu is the Box toolbox. The final menu contains the 
Circle/Oval tools. 
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A QUICK OVERVIEW 

Free-Hand Tools 

When using the Free-Hand tools, you can adjust the Line 
Thickness, Brush Shape and Shading Density (airbrush). 
These features are explained later in this chapter. 

Connected Pixel Brush 
Click on the squiggled line in the Free-Hand Draw menu. 
You are now ready to start drawing, just as you did before. 
The Connected Pixel Brush draws a solid line. No matter 
how quickly you draw, the line will not have gaps. While 
using the Connected Pixel Brush you can change the color 
or pattern (as you have already learned to do) . 

. 
I",) , 
, r 
"'- . 

Unconnected Pixel Brush 
The Unconnected Pixel Brush works just like the Connected 
Pixel Brush, except that the lines it draws may have gaps 
between the points in the line depending on how fast you 
move the mouse. This tool is especially useful with larger 
brushes, becaue it allo.ws you draw faster while still 
achieving the same effect. Access the Unconnected Pixel 
Brush by placing the cursor on the Free-Hand Draw Menu, 
and depressing the mouse button. Hold the button down 
for a moment. Notice that the top box always displays your 
current menu choice. The three boxes below display all of 
your possible choices. As you move the cursor through the 
icons, the Status Line changes to tell you what each to 0 I 
does. Now, move the cursor down to the dotted squiggly 
line and release the button. You can now draw with the 
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A QUICK OVERVIEW 
Unconnected Pixel Brush (Note that the Status Line has 
changed to reflect your currently selected tooL). Try 
drawing a few lines to see the difference between it and 
the Connected Pixel Brush. 

The third function in the Free-Hand Draw menu is the 
Zoom. :~t IS explained in Chapter Two. 

Line-Draw Tools 

When using the Line-Draw tools, you can adjust the Line 
Thickness. Brush Shape and Shading Density (airbrush) 
have no effect on these tools. 

Straight Line Tool 
This tool lets you draw straight lines with a simple c 1 i c k 
and drag of the mouse. First, select the Straight Line tool 
by clicking on it and move the cursor to the point at which 
you would like to start your line. Now. press the mouse 
button down. While continuing to hold the button down, 
move the cursor away from the starting point to the point 
where you want the line to end. Release the mouse button. 
A line now appears on-screen and the cursor is free to 
continue drawing. 

Connected Lines 
Use the Connected Line tool to draw connected lines in 
which the end point of the first line becomes the starting 
point for the second line. Pull down on Line-Draw menu 
and select the Connected Line tool. Position the cursor at 
the starting point of the new line and click (press and 
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A QUICK OVERVIEW 

release) the button. This sets the starting point of the line. 
Now, move the cursor to the location .•. ¥ .. tIre ilines' '"end point 
(this is also the beginning point or yoiir"next line) and 
click again. Move to the end point ~f the next line and 
click once more. A second line appears. Continue drawing 
connected lines in this manner. 

By holding down the mouse button while using the 
Connected Line tool, you can draw free-hand. When you 
release the mouse button, you can resume drawing in 
Connected Line mode. This feature allows you to create 
polygons that are composed of both curves and straight 
lines without having to change tools. 

To reset the Connected Line Tool, press· ESC. You can now 
start a new set of connected lines. You will see th"at the ESC 
key works with all the tools and is a very useful feature. 

Radiating Lines 
The Radiating Lines tool lets you create lines that radiate 
out from a central point like the spokes on a wheel. Select 
the Radiate Lines tool from the Line-Draw menu. Click the 
mouse button at the point on the screen that you want the 
lines to radiate from (the central point). Now, move the 
mouse to the point at which you want the line to end and 
click again. Continue to select new end points for your 
lines. The start point will always be the certttal point. 

Note: A variety of interesting effects can be created by 
holding mouse button down while moving the cursor 
around the central point. Experiment by moving the 
mouse at different speeds and distances. Press ESC when 
you want to select a new central point. 
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A QUICK OVERVIEW 

ConStrained Lines i -, 
The Constrained Lines tool works Just like the Straight 
tool, except that it only allows straight horizontal 
vertical lines to be drawn. Select the Constrained 
tool from the Line-Draw menu and experiment with 
see how it works. 

Box Tools 

Line 
and 

Lines 
it to 

Line Thickness may be adjusted with all the Box tools. 
Brush Shape and Shading Density have no effect on Box 
tools. 

Outline Box 
The first selection in the Box menu is the Outline Box tool. 
It is used to make square and rectangular shaped frames. It 
works in basically the same way as the Eraser tool. Select 
the Outline Box tool and press the button down at the 
location of one corner of your box. Now, while still 
holding the mouse button dowri, drag the mouse down and 
to the right. When the on-screen box is the correct size, 
release the mouse button. Experiment with different box 
sizes by anchoring the start point and moving the cursor 
around the screen. Remember that you can use patterns as 
well as the solid foreground colors. 
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A QUICK OVERVIEW 

Filled Box 
The Filled Box tool operates in exactly the same way as the 
Outline Box tool, except that when you release the mouse 
button, the box that appears is filled with the selected 
foreground color or pattern. 

Concentric Boxes 
The Concentric Box tool draws a series of boxes with the 
same center point and can be used in two different ways. 
The first method works almost like the Outline Box Tool. 
Press the button down and drag the mouse to form a box. 
Now, release the mouse button. You can still adjust the size 
of the box. When the box is the correct size, click the 
mouse button and the box appears on-screen. Move the 
mouse again, and another box outline appears. Its' central 
point is the same as that of the first box. 

The second method of building concentric boxes allows you 
to first set the central point around which you will build 
the boxes. This is useful when you are doing preclsIOn 
work. Place the cursor at the point that will be the center 
of the box and click once. Now, as you move the mouse 
around, you see a box that builds around that central point. 
Click again to make the box appear on-screen. Reset the 
tool by pressing ESC. 
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A QUICK OVERVIEW 

§ 
Outline Rounded Box 
This tool works in exactly the same fashion as the Outline 
Box tool, except that the corners of the box will be rounded 
instead of square. Try making some boxes of different sizes 
to see how this works. You can set the degree of 
"roundness" for your corners. This feature is explained 
later in the manual. 

Filled Rounded Box 
The Filled Rounded Box tool works like the Filled Box tool, 
except that the corners of your filled box are rounded 
instead of square. The "roundness" of these corners may 
also be adjusted. 

Concentric Rounded Boxes 
This tool works like the Concentric Square tool, except that 
the corners of your box will be rounded, instead of square. 
As with the other "rounded" tools, the corners are 
adjustable. 

Grid Box 
This tool lets you draw "gridded" boxes. Select the Grid Box 
tool and make a box just as you would with any of the other 
Box tools. The spacing of the grid lines is adjustable. This 
feature is explained in Chapter Two. 
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A QUICK OVERVIEW 
Circle and Oval Tools 

Line Thickness may be adjusted with all the Circle and Oval 
tools. Brush Shape and Shading Density have no effect on 
Circle and Oval tools. 

Outline Circle 
The' Outline Circle tool creates circles. To use this tool, 
select it from the Circle Tool menu. Place the cursor at the 
point that will be the center of the circle. Press the mouse 
button down and while holding it down, move the mouse 
away from the center point. When the circle is the desired 
size, release the mouse button. 

Filled Circle 
The Filled Circle tool works in exactly the same way as the 
Outline Circle tool, except that the finished circles will be 
filled with the currently selected foreground color or 
pattern. 

Concentric Circle 
The Concentric Circle tool works in the same way as the 
Concentric Square tool. You may simply draw your first 
circle around which all additional circles will be 
concentric, or you may point and click to set the exact 
center. All the circles created will have the same center 
point. 
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A QUICK OVERVIEW 

Outline Oval 
The Outline Oval tool works like the Outline Circle tool. The 
size and shape of the oval depend on the direction the 
cursor moves once the center point is fixed. Move the 
cursor vertically, and the oval is tall and narrow; move it 
horizontally and the oval is short and wide. 

Filled Oval 
This tool works like the Filled Circle tool, except that it 
makes oval-shaped objects. 

Concentric Oval 
Use this tool in the same manner as the Concentric Square 
and Concentric Circle tools to construct concentric ovals. 

SELECTING BRUSHES 

There are three factors affecting the brushes you draw 
with: line thickness, brush shape, and shading density. 
There is a different pop-out menu to control each of these 
factors. These three menus are located just to the left of 
the Color Status Box in the Lower Menu. 
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A QUICK OVERVIEW 

Line Thickness 

The line thickness may be set at five different points. To 
select a line thickness, move the cursor to the Line 
Thickness menu and hold the mouse button down. The 
different selections will pop up. Move the cursor up to the 
line thickness you want to draw with, and release the 
mouse button. Note how the Line Thickness menu has 
changed to reflect your choice, To draw with this new 
thickness, click on the Connected Line tool or one of the 
other drawing tools, and draw a few squiggles, lines, 
squares, etc. Remember that Line Thickness can adjust 
ALL the drawing tools. 

Brush Shape 

The menu directly to the right of the /Line Thickness menu 
controls the shape of the brush. Tlrere are eight different 
brush shapes to choose from. The first six are fairly 
straight-forward and· can be understood best through 
experimentation (Note: Diagonal lines work best for 
showing brush shape). Remember that Brush Shape 0 n 1 y 
affects the Free-Hand tools. 

The pencil brush draws a line that is one pixel in size. This 
is even narrower than the thinnest line thickness. 
Therefore, when this tool is selected, the Line Thickness 
menu has no effect. Use this brush shape for detail work. 
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A QUICK OVERVIEW 

The Text brush shape (T), lets you use any letter, number, 
or string of text as a brush. The techniques for using this 
tool are explained in Chapter Two under Text. 

Shading Density 

The Shading Density menu lets you change the number of 
foreground pixels in relation to the background. It's like 
painting with an airbrush. Remember that Shading 
Density only affects the Free-Hand tools. 

Currently, the Shading Density menu (located to the right 
of the Brush Shape menu) shows a solid black square. 
Before using the Shading Density tool, go back to the Line 
Thickness menu, and select a thick line. Also, be sure you 
are using one of the first six brush shapes. Now, activate 
the Shading Density menu. You will see five squares of 
varying degrees of blackness. Select the middle one of the 
five, then move the cursor to the painting area and click 
the mouse button once. A fine spray of color appears. Note 
that if you keep the mouse button down without moving to 
a new location, the paint continues to build up in one spot. 
Play with the different pixel densities and watch how they 
affect the airbrush. This feature works best with the 
Unconnected Pixel Brush. 

Fills 

The Graphics Studio provides you with the four types of 
fills detailed below. 
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A QUICK OVERVIEW 

~ 
Flood Fill 
The Flood Fill fills an entire enclosed area with a single 
color or a pattern. Select the Flood Fill tool and" a color or 
pattern to fill with. Position the cursor inside the area to 
be filled and press the button. Remember that any tim e 
you fill an area you must be sure that the area is entirely 
enclosed, so the color can not "le~k" out. If the color does 
leak, press ESC to stop the fill process, then remove the 
incorrect fill with Undo. 

Horizontal Line Fill 
This tool fills in a horizontal line with the current color or 
pattern. The width of the line drawn depends on the line 
thickness selected. Position the cursor on the screen and 
press the mouse button to start a fill. For an interesting 
effect, hold down the mouse button and move the cur s 0 r 
around the screen. 

Vertical Line Fill 
The Vertical Line Fill works as above, except that it fills 
with a vertical line as opposed to horizontal. 

Polygon Fill 
To draw and fill a polygon with up to 255 sides, use the 
Polygon Fill tool. After selecting the Polygon Fill, position 
the cursor at the starting point of the polygon and click 
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A QUICK OVERVIEW 
the mouse. button. Move the cursor to the end point of the 
first line of the polygon and click again. Continue 
drawing in this manner until you have your completed 
polygon. After you have set your last point, click the 
mouse button again :without moving the mouse (or press 
the Return key). The enclosed area will be filled with the 
selected color or pattern. If the polygon does not fill, this 
means that the mouse has moved since you set your last 
point. 

Note: After completing your first line, . you may hold down 
the mouse button and move the cursor to create curves and 
shapes as if you were in Free-Hand Draw. When you 
release the button, . you can continue making straight 
lines. This feature allows you to create filled polygons that 
are composed of both curves and straight lines wit h 0 u t 
having to change tools. 

FULL PAGE VERSUS CLIP SCREEN 

The Graphics Studio gives you two separate pages to draw 
on at one time. They are called "Full Page" and "Clip 
Screen". "Full Page" describes the working area that 
appears when you first start The Graphics Studio. The "Clip 
Screen" is a second separate screen that, can be accessed by 
clicking on the words "Full Page" in the Upper Menu. To 
get back to the Full Page, click on "Clip Screen". 

All the features of The Graphics Studio are available, no 
matter which screen you are on. You can even perform 
Junctions such as copy or rotate from one screen to the 
other. The only difference between the two screens is the 
size of the accessible work area. The Clip Screen is limited 
to one full screen in height, while the Full Page allows you 
to work with a page that is two full screens high at once. 
To learn omare about using these two pages, see "Picture 
ScrQIUng" below. 
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A QUICK OVERVIEW 
To view the two Full Page screens at the same time, select 
Show Page from the Options menu. The new screen will 
show your entire picture. The jog in the vertical line 
shows you what part of the picture you will return to w hen 
you exit the Show Page feature. This area may be changed 
by holding the mouse button down and sliding the line up 
or down to the correct area. 

PICTURE SCROLLING 

This is a very important and powerful feature. While on 
the Full Page, it allows you to scroll' ,the" screen up and 
down giving you the equivalent of two screens of drawing 
area. If you are on the Clip Screen, the scrolling allows 
you to move up or down to see and work the area covered 
by the menus. 

To make small changes in the position of the screen, click 
on the up or down arrow. ,This ca,uses the screen to move 
in one line increments. To move, quickly 'from one' place to 
another, click on the Slide Bar (next to the arrows), and 
while holding the mouse button down, move the Slide Bar. 
Note that the Drawing Area will be updated while you are 
still holding down the button allowing you to get the exact 
placement yori wish .. 

THE X Y COORDINATES 

Your drawing is divided into dots called pixels each of 
which has a defined location in terms of its' x (horizontal) 
and y (vertical) coordinates. The numbering of the 
coordinates starts in the upper left-hand corner of your 
drawing at x = 0, y = O. To activate, this feature, click on 
"X Y" in the Upper Menu. Now, whenever you are working 
in the drawing are~, the X and Y coordinates of your 
current cursor position are displayed. The x, and y values 
for the area under the menus can be determined by 
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A QUICK OVERVIEW 

scrolling it into the visible portion of the screen. Note: 
This feature may slow down some drawing tools, especially 
drawing with brushes. 

THE REPEAT FEATURE 

The letter "R" under Undo, is the Repeat feature. By 
clicking on (thus highlighting) "R", it makes the 
currently selected function repeatable. If the "Rn does not 
highlight, it means that the Repeat feature is not available 
with this function. To turn the Repeat feature off, click on 
"R" once more. Repeat works with the following tools: All 
Line-Draw, Box, and Circle/Oval tools, Copy and Last Copy, 
X-Copy, and Rotate. 

To get a feel for how it works, select the Straight Line tool 
and turn on Repeat. Now, draw a straight line. When you 
release the mouse button, you have a straight line that you 
can place anywhere on-screen. No matter how many lines 
you put down, you can always place another one exactly 
like the first. This is because Repeat is selected. 

You have now learned about some of the basic drawing 
functions, brushes and effects possible with The Graphics 
Studio. In the next chapter, we will discuss capabilities 
such as rotation, text, loading and saving 
copying, and patterns. 
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CHAPTER TWO: 
USING 11iE GRAPHICS STUDIO 

This chapter of the manual covers the bulk of The 
Graphics Studio program. Here, you will learn how to use 
features such as text, zoom, and rotation. If you are already 
familiar with how graphics programs work, this is a good 
place to start. If you are new to this type of program, you 
will want to start with Chapter One. 

THE MODE MENU 

One of the truly unique features of The Graphics Studio is 
the Mode menu located at the far right of the Menu Bar. 
Depending on the feature currently selected, the Mode 
menu displays different options. All of the features 
covered in Chapter One will have their mode options 
explained below. Note: Shadow and Mirror will stay on no 
matter which Drawing Tool you select until you turn them 
off. 

In the Mode menu many of the items can be toggled on and 
off. When you select one of these items the menu remains 
down. This alternative approach to pull-downs allows you 
to turn a number of items on and off without having to 
pull the menu down again. 

The Drawing Tools 

All of the Drawing Tools covered in Chapter One have the 
following options in the Mode menu: Rotate Colors and 
Random Colors, Shadow and Mirror, and Set Shadow, Set 
Mirror Type and Set Mirror Origin. A lot of fun can be had 
by turning on all the modes at once and working with the 
different drawing tools. If that's not enough ex cit e men t 
for you, add Repeat, Airbrush, and Color Cycling!! 
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Rotate Colors 
The Rotate Colors feature allows you to rotate through a 
sequence of colors as you draw. Simply select any Drawing 
tool (let's use the Outline Circle with Repeat as an example), 
then move to the Mode menu and turn on Rotate Colors. 
Now, each circle you draw will be a different color as the 
program rotates sequentially through the selected range 
of colors. 

To set the color range, select Edit Colors/Cycling from the 
Edit menu (or place the cursor on the palette and press 
Command-D). The Palette Edit menu will appear. At the top 
of the menu, is a Color Bar displaying the current colors in 
your palette. Attached to the Color Bar is a horizontal line 
stretching from one end of the bar to the other. By 
placing the cursor at either end of this line and holding 
the mouse button down, you can slide the ends of the line. 
The color range is made up of the colors enclosed by the 
attached line. 

This menu contains 
explanation of the 
Chapter Three. 

Random Colors 

many 
color 

additional 
palette 

features. 
editing 

For a full 
features see 

The Random Colors option works like Rotate Colors, except 
that the colors are selected at random from the entire 
palette. 

You may turn on Randum Colors and Rotate Colors at the 
same time. In this case, only the colors in the color range 
are used, and they are selected at random. 

Shadow 
If you select Shadow from the Mode menu, an off-set drop 
shadow function is automatically added to your currently 
selected Drawing tool. As an example, select the Filled Box 
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USING THE GRAPHICS STUDIO 
tool, then go to the Mode menu and turn on Shadow. Go 
back to the Drawing Area and make a few boxes. 

Set Shadow 
Let's say you want to change the color or the off-set of the 
Shadow. To do this, select Set Shadow from the Mode menu. 
To change the shadow color simply click on any color in 
the palette (Patterns can not be selected as shadows). 

To change the drop shadow off-set, you need to adjust the X 
and Y settings. To do this, place the cursor on the number 
you wish to change, hold the mouse button down and move 
the mouse up to increase the number or down to decrease 
it. The numbers are may range from -20 to 20. The 
following chart shows how the numbers affect the shadow. 

X is positive Shadow is to the right of the original. 
X is negative Shadow is to the left of the original. 
Y is positive Shadow is below the original. 
Y is negative Shadow is above the original. 

By varying the different X and Y settings, you can achieve 
a number of shadow effects. As an example, if X is positive 
and Y is negative, the shadow will be to the right of and 
above the original. 

Mirror 
The Mirror effect reflects your drawing actions. Select the 
Straight Line tool and turn on Mirror. When you move the 
cursor back on to the Drawing Area, a number of lines will 
divide the Drawing Area into the reflection areas that will 
be there when you draw.· The default number is eight. For 
a quick visual example of how this works, hold down the 
mouse button and draw a straight line. You will see the 
effect on-screen. Now, with the button still down, continue 
to move the mouse. Practice like this to see the different 
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effects. Now, try it with Repeat on. 

Mirror Type 
To adjust the number and' type' of reflection, select Set 
Mirror Type from the Mode menu. A dialog box shows the 
reflections available. Click on your choice, then on OK to 
confirm it, and return to the Drawing Area. The dividing 
lines now reflect your new selection. 

Mirror Origin 0 

To change the ongm (center point) of the' mirror, select 
Set Mirror Origin from the Mode menu. When you move 
back to the Drawing Area, the dividing lines follow the 
cursor. The new origin point is set by clicking the button. 

In addition to the general options above, the following 
special mode options are available. 

Use Brushes 
Use brushes works with Connected and Uncon'hected Pixel 
Brushes. When it is off, you can draw at .. ' the highest' speed, 
but can only alter the Line Thickness. Brush Shape and 
Density have no effect. When it is turned on, these tools 
operate more slowly, but you can change Brush Shape and 
Density, as well as Line Thickness. When The Graphics 
Studio starts, Use Brushes is turned off. 

Outlining Filled Objects 
To give a filled object a border of a . different color, turn on 
Outline Filled Shape. To set the outline color, first set the 
foreground color to the desired outline color. Then, select 
Set Outline Color from the Mode menu. Now, return to the 
Color Status Box and select the color for the' filled object . 

• , ./! ' 

Setting the Corner Roundn~ss 

To set the corner roundness of the Rounde,d Box tQols, 
select Set Corner Roundness from the Mode menu. You can 
change the X and Y radii in two ways. You may click in the 
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box displaying the current radius setting and type in your 
new choice followed by Return, or you may position the 
cursor over the box, and while depressing the mouse 
button, slide the mouse upwards to increase the number or 
down to decrease it. As the numbers change, the box above 
automatically reflects these changes. The setting can 
range from 1 to 100. If both radii are set at 1, the corner is 
square. If they are both at 100, you can make circles and 
ovals. When the corner is correct, click OK to exit. If you 
don't want to use your changes, click on Cancel. 

Fills 

Rotate and Random Color work with the Horizontal and 
Vertical Line Fills as they do with the Drawing Tools. They 
are not available with the Flood and Polygon Fills. 

Outlining is available with the Polygon Fill tool. It works 
in the same manner as the Outline modes described above. 
The Outline options are not available with the other fills. 

ZOOM 

Zoom magnifies the selected portion of 
detailed precision work a lot easier. 
magnification are: 2X, 4X, and 8X. 

a picture, making 
The levels of 

Select Zoom from the Line-Draw menu. A rectangular box 
appears. Position the box over the area to be magnified, 
and click the button. A new screen divided into two parts 
appears. The upper portion displays part of your picture 
with the Zoom box on the selected portion. The lower half 
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displays a copy of the area within the 
default level of 4X magnification. Note: 
Zoom, the Mode menu may be used 

rectangle at the 
Before entering 

to change the 
magnification level. 

Use the X icon in the new Lower Menu to change the 
magnification level. The screen updates automatically. 
The Zoom box in the upper half of the screen shows the 
new area of magnification. 

To zoom in on another area of the picture, move the cursor 
to the top half of the screen and press the button to m 0 v e 
the Zoom box to the new area. The bottom portion is 
instantly updated. 

While in the Zoom mode, you can use the Pencil and Fill 
tools in combination with any of the solid colors or 
patterns. Note that if the pixel you start painting on is the 
same as the currently selected foreground color, it will 
paint over it with the current background color (This is a 
handy quick-erase feature.). 

Additional options are available in the menu bar 
separates the upper and lower portions of the screen: 
Coordinates Gust click on it to activate) and Undo. 
Zoom, click on the box at the left end of the menu 
press Esc. 

DRA W1NG ON THE GRID 

which 
X Y 

To exit 
bar or 

The Graphics Studios' Draw On Grid feature constrains your 
drawing functions to grid of dots in the Drawing Area. The 
grid itself is not visible, but the effect can easily be seen 
by turning on the X Y coordinates and watching the X Y 
values as you move the cursor around the Drawing Area. 
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This is handy for precISIOn cursor placement, and makes it 
easy to draw parallel lines or a series of geometric designs 
of any type. If you're drawing a floor plan, use this 
feature to be sure everything is to scale. To get a feel for 
how its works, use the Unconnected Pixel tool with the grid 
off and then turn the grid on and draw again. See the 
difference? 

To turn it on, select Draw On Grid from the Options menu. 

You can alter the spacing between grid points quickly and 
easily. Select Set Grid Spacing from the Options menu to 
bring up the Grid Dialog Box. Set the X and Y coordinates 
by clicking in the box and typing in a new number, or by 
holding the mouse button down and moving the mouse up 
to increase the number or down to decrease it. As the 
numbers change, the grid in the dialog box will change to 
show you the spacing. The spacing can range from 1 to 50. 

The Grid Box tool, explained in Chapter One, lets you draw 
boxes that are filled with a grid pattern. The spacing of 
these grid lines is determined by the current settings in 
the Grid Dialog Box. 

To reposition the points on the grid by selecting Change 
Grid Origin from the Options menu. When you return to 
the drawing area, the cursor changes to a large crosshair. 
Set the intersection of the two lines in the crosshair at the 
new grid point. Note: If you want to set the grid point to a 
specific coordinate on the Drawing Area, turn on the X Y 
Coordinate feature prior to changing the grid origin. For 
example, if the grid spacing setting is 8,8, and the grid 
origin is set at 5,5, your X Y coordinates will move from 5,5 
to 13,13, then to 21,21, etc. 
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THE COPY TOOLS 

The Copy tools are located to the right of the Fill tools (See 
Figure 2). The Copy menu contains the following features: 
copy, last copy, capture pattern, rotate, scale, exchange 
colors and flip. 

r--, 
! c: 
1- __ .... 

Copy Area 

To use the Copy feature, select it from the Copy Menu. 
Move to the Drawing Area. Press the mouse button dow n 
and drag the mouse and to form a frame around the area 
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you wish to copy. Release the button and your copy is 
picked up from the screen. Simply move the on-screen 
frame to the location you wish to copy to, and press the 
button to drop the copy into place. For more precise 
placement, use the arrow keys to position the copy, and 
press Return to place it. You can also hold the mouse 
button down and use the copy like a paintbrush. Don't 
forget that you can copy fro'm the Full Page to the Clip 
Screen and vice-versa. 

The frame containing your copy will appear to be empty 
while the mouse is in motion. When the mouse stops 
moving, your copy reappears (Note: If the Repeat function 
is turned on, the copy will not appear until it is actually 
dropped onto the picture.). 

There are a number of options available in the Mode Menu 
during copy. They are explained below. 

Replace 
If Replace mode is on, the copied section will completely 
replace whatever area of the picture it is dropped on. 

Transparent 
In Transparent mode, the currently selected background 
color becomes "invisible". When the copied section is 
placed over another part of the picture, the picture will 
show through. the "invisible" portions of the cop i e d 
section. 

Copy and Cut 
If you select Copy from the Mode menu, the area you lift 
your copy section from will not change. If you select Cut, 
the area you lift your copy section from will be replaced 
with the current background color. Either Copy or Cut 
may be used in conjunction with either Replace or 
Transparent. 
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r--, 
! L: L.. __ ~ 

Last Copy 

Last Copy allows you to recall and use the information in 
the last Copy Area executed. Other drawing tools can be 
used in between and the last copied area will still be 
available. Note: If you edit Color Cycling or load a picture 
with Color Cycling off the disk, the last copied area will no 
long·er be available. It's just one of those things .... 

r--, 
! P: 
1.. __ .... 

Capture Pattern 

Capture Pattern allows you to grab any 8 x 8 area of your 
picture and place it in the Pattern Palette. This feature is 
explained below in "Working with Patterns". 

r--, 
!XC: 
1- __ ..1 

Change", Color in Area 

This feature lets you replace a color in the picture with 
any other color from the palette, or you may swap two 
colors in the picture with each other. 

Replace 
To replace a color in the picture, select the "XC" tool from 
the Copy menu and set the mode to Replace Color. Set the 
currently selected foreground color to the color to be 
changed and set the background color to the target color 
(Remember, to set the background color, click in the 
background area of the Color Status Box, and then click 00 
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the ,desired color.). Move to the Drawing area and 
construct a frame Uust as you do in Copy Area) around the 
area to be changed. When you release the mouse button, 
the foreground color in this area will be replaced by the 
background color. If Repeat is turned on, you will have a 
box that you can move around the s~reen. Anytime you 
click the button, the replacement will occur. 

~ 
To swap two colors in the picture, select the "XC" tool and 
set the mode to Swap Colors. Set the foreground and 
background colors to the two colors you wish to swap. M 0 v e 
to the Drawing area and construct a frame Uust as you do 
in Copy Area) around the area to be changed. When you 
release the mouse button, any area inside the frame which 
is the foreground color will change to the background 
color and vice-versa. If Repeat is turned on, you will have 
a box that you can move around the screen. Anytime you 
click the button, the replacement will occur. 

r--, 
101 
• I L.. __ ~ 

Rotate Area 

To rotate a section of the picture, select the Rotate Area tool 
from the Copy menu. Set the cursor at the center point of 
the area you wish to rotate. Hold down the mouse button 
and move the mouse until the area you wish to rotate is 
enclosed by the on-screen frame, then release the mouse 
button. You- can now use the mouse to rotate the box to its' 
new location. When the box is in position, click the mouse 
button. The computer will redraw the selected area in its I 
new rotated position. N ate: As you rotate the frame, you 
may notice that it changes shape. This is because the 
pixels are not square. 

31 



USING TI-lE GRAPHICS STUDIO 

The Mode menu has a number of options that can be used 
with Rotate Area. Replace, Transparent, Copy, and Cut 
work as the do with the Copy Area tool explained above 
(See this section of the manual for information on how 
these four options can be used in combination). If you 
turn on the Replace feature, everything enclosed in the 
box will paint over the area on which you place your new 
rotation. With Transparent selected, the currently selected 
background color is considered "invisible". When the 
rotated section is put into place, the original picture will 
show through the "invisible" portions of the rotated 
section. Just for fun, you might ·like to turn on Repeat 
while rotating in Transparent mode, to create a fan-like 
effect. 

Free Rotation 
This Mode menu option allows you to rotate the selected 
area to any angle you desire. This is the initial setting for 
the Rotate Area tool. 

45 Degree 
This option allows you to rotate your selected area in 45 
degree increments. 

Scale Area 

Scaling gives you the ability to change the size of an object 
to make it either larger or smaller. Select Scale Area from 
the Copy menu. Form a frame around the area you wish to 
scale. Now, move the cursor to the area that you want the 
scaled image to appear in, and form another frame that is 
the size and shape that you want your scaled image to be. 

32 



USING 11-IE GRAPHICS STUDIO 
Release the mouse button and your scaled image will be 
drawn on-screen. 

The Copy and Cut mode selections work with Scale as they 
do with the other Copy tools. 

~ In:]1 ~ 
Flip 

The Graphics Studio gives you the ability to flip images 
horizontally, vertically, or both. Simply select the 
appropriate Flip tool from the Copy menu, and form a 
frame around the area you want to flip. When you release 
the button, the selected area will be flipped. 

WORKING WITH PATTERNS 

The Graphics Studio gives you a wide range of capabilities 
to work with. This is especially true when you are 
working with patterns. As we have already seen, patterns 
can be selected and used as the foreground color in 
combination with any function. In addition to the patterns 
that come with The Graphics Studio, you can create and 
save an infinite number of additional ones. 

r--, 
! P: 
'- __ .I 

Capture Pattern 

The Capture Pattern tool is found in the Copy Menu. It 
allows you to capture any 8 x 8 pixel area of your picture 
and store it in the pattern area of your palette. 
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To capture a pattern, first select one of the patterns 
already in your palette. Your new captured pattern will 
replace this one (If you do not select a pattern to replace, 
the program will automatically use the first pattern slot.). 
Next, select Capture Pattern from the Copy Menu. When 
you move to the drawing area, you will notice that the 
cursor has been replaced by a small box. Move the box to 
the area of the screen that you want to "capture" and click 
the mouse button. Your new pattern appears in' the' 
currently selected pattern position in the palette. 

If you don't like what you see, simply move the rectangle 
and click again. You can also hold the mouse button down 
and move the rectangle until the desired pattern appears1 
in the palette, and then release the button. 

Edit Pattern 
The Edit Pattern function allows you to modify exuiltlDg 
patterns, or design a new one from scratch. To access this 
feature, you may double-click (or Command-click) on the 
pattern area of the palette, or select "Edit Pattern" from the 
Edit pull-down menu at the top of the screen. 

Once selected, the Edit Pattern dialog box appears. The 
large box on the left shows a magnified, version of the 
currently selected pattern.' This is the area where you will 
do your editing. The smaller box below shows the pattern 
as it will appear when in use. As you make changes to the 
pattern, these alterations are instantaneously reflected 
here. The group of patterns on the right side are your 
Auxiliary Patterns. You may swap them into the palette in 
the Lower Menu, and then edit them. Additional files can 
be called up by clicking on the Files option. 

To edit an Auxiliary Pattern, click on the pattern you wish. 
to edit. The pattern will be displayed in the magnified edit 
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area and in the currently selected pattern slot in th e 
Lower Menu. The pattern that was in the selected slot in 
the Lower Menu moves to the Auxiliary Pattern area. 
Alternatively, you may drag an Auxiliary Pattern onto a 
pattern slot in the Lower Menu. 

If you wish to edit a pattern from the Lower Menu, click on 
the desired pattern and it will be displayed in the 
magnified area. Once you are finished editing, clitk on the 
Put Pattern option to place your new pattern in the Lower 
Menu palette. 

Along the left side of the Magnification Box are four 
positioning arrows. They will move the pattern in any of 
the four directions. This feature is quite useful when a 
pattern has been captured from the screen and it needs to 
be realigned. 

Xcolor will replace one color in the pattern with the 
currently selected foreground color. To use, just select 
Xcolor and click on the color in the pattern that you wi s h 
to replace. 

Fill and Undo work in the same manner here as they do in 
other parts of the program. Fill can be toggled on and off. 
You can also edit your pattern using any of the solid colors 
from the palette. Simply select a color, move the cursor to 
the editing area , and draw. The first mouse click puts 
down the foreground color. A second mouse click in the 
same spot puts down the background color. The Clear 
option clears the editing area to the currently selected 
background color. 

Once your changes are completed, click on OK to exit. If 
you decide you don't like the changes, click on Cancel. 
This exits you from the Pattern Editing feature without. 
changing anything. Note: If you accidentally select 
Cancel, you may still recover by going back to the Edit 
Pattern menu and immediately clicking on Undo. 
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[TIQ] 
TEXT TOOLS 

The Graphics Studio lets you add text to any of your 
pictures using a number of fonts of various sizes and 
styles. Once it has been placed on your picture, it can be 
rotated, flipped, or sized just like any other part of the 
picture. You can use any IIGS font as long as it is on your 
disk. See your IIGS documentation for instructions on 
moving fonts from one disk to another. 

The Text tools are located at the far left of the Upper Menu. 
Click on the T and move the cursor to the drawing area. 
Click the mouse button at the point you want the text to 
begin and start typing (Note the new cursor shape.)! 

The appearance of the text can be changed in a number of 
ways. You can change the color, the font, or use any of the 
special effects detailed below. When you make a change of 
this type, the change is not reflected on-screen until the 
cursor has been moved into the Drawing Area. 

When you finish a line of text, it is not anchored on the 
screen until you press Esc or Return (Note: Once a line of 
text is anchored, it can no longer be edited). Return starts 
a new line of text directly below the previous line. Esc 
starts a new line of text where the previous line ended. 
This feature let you mix colors and styles in one line. 

Positioning Text 

To move unanchored text, place the cursor at the new 
location and click the mouse button. The text will jump to 
the new location. Alternatively, you can hold the mouse 
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button down and drag the text to the desired location. To 
make fine adjustments to the location, use the appropriate 
arrow key to move the text in one pixel increments. 

Text Modes 

The Mode Menu contains a number of options for 
modifying text. Replace and Transparent work as they do. 
in other areas. In Replace mode, the currently selected 
background color is part of the letter and writes over the 
picture. In the Transparent mode, only the letters are 
placed on the picture. 

You can change the look of your text with five different 
"special effects": bold (a heavy thick line), underline (a 
solid line placed under each character), shadow (adds a 
drop shadow), outline (uses the foreground color' to create 
a line around a character's shape, leaving a hollow center 
in the background color), and italic (slants the vertical 
line of the text to the right). You may have as many of the 
special effects on at once as you desire. A check-mark next 
to the effect indicates that it is turned on. It is best to type 
in your text without special effects. Add the desired effects 
just before anchoring the text. Note: Some effects are not 
available on some font sizes. 

"Center Text" lets you center a string of text along the X 
(horizontal) or Y (vertical) axis, or both. Select the 
centering method from the dialog box that appears after 
selecting "Center Text. .. " from the Mode menu. The 
Graphics Studio centers text as follows. To center on both 
axes, it searches outward from the center of each side of 
the text string until it encounters a color other than the 
currently selected background color. The text is then 
centered between these four points. When centering 
vertically or horizontally, it searches from the top and 
bottom or left and right respectively. 
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Selecting a Font 

To select a Font, click on the Select Font tool. The dialog 
box allows you to choose your font and size. Just click on 
your choice and it will be selected. Note: The style settings 
have no effect. To select style settings, use the Mode menu 
after you have made your other font selections. 

The Text Brush Shape 

The Text Brush can be a fun, if somewhat confusing, 
feature. There are two ways to use the Text Brush. The 
first is to enter some text using the Text tool (as described 
above) without anchoring it. Now, select the Text Brush 
from the Brus-h Shape menu, and either of the drawing 
tools in the Free-Hand Draw menu (Unconnected Pixel 
works best). You may now use the text you typed in as a 
brush. 

To use the second method, you must first get rid of any text 
you may have typed in. Select the Text tool, move the 
cursor into the Drawing Area, and press Esc. Select the 
Text Brush from the Brush Shape menu, and either of the 
drawing tools in the Free-Hand Draw menu (Unconnected 
Pixel works best). Now, type a single character. This 
character is now your brush. To change brushes, simply 
type in a new character. This feature is useful if you want 
to drop a series of asterisks (as an example) in the 
background. 

You can use this effect to create any number of interesting 
effects. Try using it with Draw On Grid selected. 

OPENING A PICTURE 

To open (or load) a picture, select Open from the File menu. 
A dialog box appears. At the top of the box is the name of 
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your disk. Below that is a list of the pictures on the disk. 
You can scroll through these by using the scroll bar 
located just to the right of the filenames. If works just like 
the vertical scroll bar in the Lower Menu. To change 
drives, click on Disk. Open lets you open a file folder or 
load a picture, while Close lets you close a file folder. Exit 
lets you leave the dialog box without loading a new picture. 

Load Palette and Load Patterns are two options that appear 
at the bottom of the dialog box. An open circle indicates 
that the option is turned off. A solid circle indicates that it 
is on. Anytime you save a picture, the current patterns and 
palette are saved too. The Color Palette and the Patterns are 
only loaded if these options are turned on. Before loading 
a picture, make sure that your Load Patterns and Load 
Palette options are set correctly. Note: Because in most 
circumstances, you will want to load the picture with its 
corresponding palette, this selection is turned on w hen 
you first start The Graphics Studio. 

To open a picture, just click on the name of the picture you 
wish to load, then on Open, or simply click twice on the 
filename. The Graphics Studio loads pictures created with 
Deluxe Paint or Paintworks Plus. Just load your pictures 
into The Graphics Studio and have at it! Now, you can do 
things you've never done before, like automatic drop 
shadows and truly powerful color cycling. 

SA VING A PICTURE 

The two ways to save your files are described below: 

Save as 

Select Save As from the File menu. A dialog box appears 
with the cursor in place and ready for you to type in your 
filename. If you wish to perform other activities first, 
simply press the Return key (or click the mouse button) 
and . the arrow cursor appears. At the top of the box is the 
name of your disk and the amount of space remaining on it 
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(Free). Below that is list of the pictures on the disk. You 
can scroll through these by using the scroll bar located 
just to the right of the filenames. It works just like the 
vertical scroll bar in the Lower Menu. To change drives, 
click on Disk. Make Folder allows you to create a new 
folder to put your files in. Just click on Make Folder and 
type the new folder name in the the box below the words 
"Save As". Open lets you open a file folder, but will not 
Hllow you to load a picture while in the Save As Dialog Box. 
Close lets you close a file folder. Exit lets you leave the 
dialog box without saving anything. 

To save a picture, just type in the filename in the box 
below the words "Save As", and press Return. 
Alternatively, you may click on the filename and then on 
Save. Note: When saving from the Full Page, be sure that 
you have correctly selected either Page Format or Screen 
Format. Page Format saves the entire two screens in 
height, while Screen Format saves the area that is visible 
on the screen (including the parts of your work that are 
under the Menu Bars). 

To rename a file, click on the file you wish to rename, and 
then on Rename. Now, type in the new file name and press 
Return. To delete a file, click on the file you wish to delete, 
then click on Delete. Note: If you accidentally select 
Rename or Delete, you may click the mouse button to 
cancel. 

Save 

Selecting Save from the File menu, lets you do a quick save 
using the filename that was last used. Simply select Save 
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from the File menu. Note: If you are saving the Full Page , 
it will ask whether you want to save the screen or the 
page, or cancel your request. Make your selection and The 
Graphics Studio will carry it out. 

REVERT 

Revert loads your last saved version of the picture from 
disk. When you are working, it is advised that you save 
your work periodically. This way, if the electricity go e s 
out, or you make an un correctable mistake, you can 
recover your previous version. 

PRINTING A PICTURE 

If your printer is set up and ready to go, select Print from 
the File menu. Choose whether you wish to print the Page 
or the Screen and then sit back and wait for the output 
from your printer. Note: You may cancel the printing 
process by holding down the Command key and pressing 
period (.) 

Selecting Print Setup... from the File menu, brings up a 
new dialog box with the options outlined below: 

Set Print Attributes: 

Quality: Select Better Text or Better Color depending 
on the type of picture you are printing. Draft gives 
you the printout faster, but the quality is lower. 

Page Range: You can set it to print everything (All) 
or set the range. 
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Copies: Select the number of times you wish to print 
the picture. 

Color: Select this if you are using a color printer. 

Set Page Style: 

Paper: Tells the program what type of paper you 
have in your printer. 

Vertical Sizing: Normal prints in the regular 
fashion. Condensed gives you a printout that is the 
normal width, while the vertical height is shorter. 

Printer Effects: 50% Reduction prints your picture 
at one half its normal size. . No Gaps Between Pages 
prints a 396 line picture. This is 4 lines short of the 
400 lines that equals 2 Full Page screen heights. If 
No Gaps Between Pages is !lQ1 selected, a 378 line 
picture is printed. 

Orientation: This determines which side of the 
paper the top of your picture will appear. 

Choose Printer: Lets you select the Printer Type and Port. 

Start Printing: Prints your picture. 

Done: Exits the Print Setup Dialog Box. 

In the next chapter. you will learn how to how to use the 
more advanced color editing and cycling features. 
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ADVANCED FEATURES 
This Chapter covers the po werful features 
available for editing your Color Palette and 
adding Color Cycling capabilities to your works of 
art. Try doing that with an ordinary pen and 
paper! !! To learn how to add an entirely new 
dimension to your creativity, look here. 

EDITING THE COLOR PALETTE 

To edit your current color palette, access the Color Palette 
Menu by one placing the cursor on the Palette and 
clicking the mouse button while holding down the 
Command key (or press the Command key and "D' 
simultaneously), or by selecting Edit Colors/Cycling from 
the Options menu. In Chapter Two, we explained how to 
quickly and easily change your Color Range when using 
the Rotate Colors and Random Colors selections. Now, you 
will learn how to move the colors from one position in the 
palette to another, create blended ranges, swap color 
pOSItIOns and create totally new colors all with a simple 
point and click of the mouse. 

Selecting a Color to Edit 

As you look at the Color Bar across the top of the menu, you 
will notice that one of the colors has a small notch below it. 
This notch indicates that that color is the currently 
selected color for editing. Note that the Color Editing Box 
also displays the currently selected color. 

To select a different color to edit, simply point the cursor to 
the color you- wish to edit and click the mouse button. The 
notch will move to that color and the Color Editing Box will 
change to reflect the new color. If you want to change 0 n e 
of the colors in your drawing, but you're not quite sure 
which color in the Color Bar is the correct one, simply 
move the cursor to the top half of your screen where your 
drawing is still visible, and click on the color you want to 
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change. The notch will move to the selected color and the 
Color Editing Box will be updated. Note: You can move the 
area of your picture that is visible in the top portion of the 
screen by scrolling your picture prior to entering the Edit 
Color Palette menu. 

Editing a Color 

The Graphics Studio gives you two powerful ways to 
change a single color in your palette. The box containing 
the letters RGB controls the Red, Green and Blue values of 
the selected color. Under each of these letters is a number 
that can range from 1 to 15. As with most other G rap hie s 
Studio features of this type, you may change the number 
by clicking on it and typing a new one in, or by holding 
the mouse button down and moving the mouse upward to 
increase the number and down to decrease it. As you do 
this, notice that the color in Color Editing Box changes to 
reflect the new values. 

For quicker and more precise color editing, use the Color 
Editing Box. This allows you to hold one value (red, green, 
or blue) constant, while you adjust the other two 
simultaneously. As an example, click on R. It will be 
highlighted (white R on a black background) and locked. 
The Color Editing Box will now let you adjust the Green and 
Blue values. If you look closely at the Color Editing Box, 
you will see a small square. This small square represents 
the current green and blue values. By moving this box, 
you can adjust these values. Simply move the cursor to the 
Color Editing Box. hold the button down and move the 
mouse to change the color. Up and to the right increases 
the color values. Down and to the left decreases them. You 
can access 256 different colors just by moving the mouse. 
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Copying Colors 

You can copy colors from one position in the palette to 
another with great ease. Simply place the cursor on the 
color you wish to copy, hold the mouse button down, and 
slide the color to its new location. 

The color that is in the position you are copying to will be 
replaced by the new color. If the replaced color was being 
used in your picture, your picture will be updated with the 
new color as well. 

Swapping Colors 

To cause two colors in the Color Bar to 
simply click on Swap, then move the first 
of the position of the second color and 
button. The two colors will swap places. 

exchange places, 
color in the swap 
release the mouse 
As with the Copy, 

the swap will also cause the two colors in your 11 i c t u r e to 
switch places. 

Blending Colors 

Use Blend to create a smooth gradation of color across your 
palette. Attached to the Color Bar is a horizontal line 
stretching from one end of the palette to the other. By 
placing the cursor at either end of this . line and holding 
the mouse button down, you can slide the ends of the line. 
The color range is made up of the colors enclosed by the 
attached line. 

After setting the range, click on blend. The colors will 
change to create a smooth gradual blend from the color at 
the left end of the range, to the color at the right end. The 
colors in your picture will be updated to reflect this new 
palette. 
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Other Commands 

Undo cancels the last change made 
Reset lets you cancel ALL of your 
again. OK exits the Color Palette 
palette to reflect your changes. 
making any changes. 

Restore Last Palette 

to the palette, while 
changes and start over 
Menu and updates the 
Cancel exits without 

Should you exit the Color Palette menu by selecting OK 
when you meant to hit Cancel. You can always get your 
last palette back by selecting Restore Last Palette from the 
Options menu. This feature will also recover the last 
palette when you load in a new picture, or when you 
switch from the Full Page to the Clip Screen or vice-versa. 

Use One Palette 

When Use One Palette (in the Options menu) is turned on, 
and a new file is loaded, its palette is loaded in to both the 
Clip Screen and the Full Page. If you want the Clip Screen 
and Full Page to use separate palettes, turn the Use One 
Palette selection off. 

COLOR CYCLING 

The Graphics Studio includes a powerful color cycling 
feature that allows you to animate your picture by 
dynamically changing the colors in the picture. This is 
accomplished by "playing" a sequence of color palettes, 
much like the frames in a film. Most graphics programs 
limit you to cycling through the colors of one palette. The 
Graphics Studio lets you cycle through many palettes. 
Here's how it works. The color that is in Position I, Palette 
1 changes to the color of Position I, Palette 2, then Position 
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I, Palette 3 and so on, as the color cycling progresses. With 
16 different positions available at once, you can see how 
powerful and unlimited The Graphics Studio is. 

To access the Color Cycling menu, open the Color Palette 
menu and click on cycling. When you first enter Color 
Cycling, you will notice the menu is divided into two 
sections. The left side controls the currently selected color 
cycling palette. The right side contains the overall 
controls for color cycling through all the palettes. Let's 
discuss the left side first: 

Slot: Each "slot" is an entire color palette. The number 
displayed under Slot, tells you which palette in the 
sequence is currently being edited. This palette is 
displayed in the Color Editing menu. Use the up and down 
arrows to step through the palettes. 

Rotate: This feature changes the position of the color s 
within the selected palette. Clicking on the left side of the 
Rotate selection moves the colors one position to the left. 
Clicking on the right side, moves them one position to the 
right. 

Add: This adds a new palette to the sequence. 
palette is inserted into the sequence directly 
palette you had been working on. 

The new 
after the 

Delete: Removes the currently selected palette from the 
sequence. Use Slot to select the palette you wish to delete. 
Then, click ~m Delete. 

Ticks: Displays the number of "ticks" (length of time) that 
the current palette is displayed when the cycling is pIa y e d. 
The smaller the tick setting, the shorter the display period. 
This allows you to control the length of time one palette is 
displayed relative to the other palettes in the sequence. 
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The right side: 

Play: This starts the color cycling. Color cycling 
be turned on and off by selecting Cycle Colors 
Options menu. 

can also 
from the 

Slots: This tells you how many palettes are in the color 
cycling sequence. 

Rate: Controls the overall speed of the color cycling. The 
higher the Rate. the more quickly it plays through the 
sequence of palettes. 

New: Discards the current color cycling and lets you start 
over again. 

Files: This allows you to save a color cycling sequence 
separate from your picture files. 

For some interesting examples of Color Cycling. watch the 
slideshow (See Appendix 2). 

SWITCHING RESOLUTIONS 

The Graphics Studio has low resolution and medium 
resolution settings. In low-res the screen is 320 x 200 
pixels with 16 colors. In med-res. it is 640 x 400 with 4 
colors. When the program starts. it is in low-res. 

To change resolutions. select Change Resolution from the 
Options menu. Save any work you want to keep before 
changing resolutions. Once the resolution change has 
been. made. you can reload your picture into the new 
resolution setting. Note: If you load a 16 color low-res 
picture into med-res. the picture will be remapped into a 4 
color picture. 
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APPENDIX ONE: 
FOR THE BEGINNER 
This appendix covers a few simple effects that are possible 
with The Graphics Studio, and helps the beginner to learn 
how to use their imagination as a starting point for new 
ideas. 

Often times, even the most ornate, complex picture beg ins 
with a simple design concept. Consider a Christmas tree. 
Instead of going up and down the sides drawing each 
branch separately, start by looking at its simplest shape -
a triangle with a rectangle for a base. It could be short an d 
fat, tall and skinny, or somewhere in between. Color it 
green, and for the trunk, attach a brown Filled Box to the 
base. Branches are quick and easy. Using the color 
surrounding the triangle (most likely the background 
color) select a small brush shape and cut out wedge shapes 
from the side of the tree. Add a few Filled Circles of 
different colors offset with a dark green shadow for 
ornaments (see pg 22 for details on setting a shadow), and 
presto - a Christmas Tree. Ok, so it's not like the one you 
see each year at Macy's. That's the whole point! The image 
described is the start of an idea. The original green 
triangle could be much more. The image could be of the 
tree that stands in front of the White House each year for 
the holidays. Or leaving off the ornaments, it is the start of 
a forest of trees on a snowy hillside. Begin by coloring the 
ones in front a bright green and those in back darker 
shades of the same color. In front, a horse drawn carriage, 
full of passengers approaches a covered· bridge. Let your 
imagination take you wherever you want to go. 

For this next one, first turn on the Repeat function. The 
moon is a great jumping off point for an idea and this one 
is a snap! With the screen filled with the black of an 
circle. Once the desired moon shape is achieved, click the 
mouse button. To expand the idea, fill in the sky with dots 
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autumn night and the Repeat function turned on, place a 
pale yellow filled circle somewhere in the upper portion 
of the screen. Using the same circle shape, select the 
background color and position it over the pale yellow 
of different sizes and colors for stars, put in a few clouds 
(gray for a night sky), add a dark gray silhouette of a 
hollowing coyote and you're done. 

Daisies can be made quickly and easily using the Radiating 
Line feature. To make the petals, set the starting point for 
the ray, and move the cursor a short distance - the r ad ius 
of the flower. Press the mouse button down and hold it as 
you move around the starting point in a circular direction. 
Next, with the starting point still anchored to the picture, 
go to the palette and select a yellow color for the flowers 
center. Repeat the move around the center point. This 
time begin the sweep at a point closer to the center. The 
finished picture should look like an Astor Daisy. Repeat 
this process several times starting each time at a new 
center. Experiment as you do this. Try different colors and 
sizes. What would they look like in the morning or in a 
rain storm? You may even want to overlap one or two 
flowers to give the illusion of depth. To make a field of 
daisies from a single flower, start with the Copy function 
in the Transparent mode. Set the background color to the 
color around the flowers and select a group of daisies to 
copy. Make several copies of the flowers and return to the 
menu. Select the scaling feature. Mark a row or two of the 
daisies and reduce them in size. Use your imagination to 
create new looks. 

As you explore new features try your skill at making a 
teddy bear using just the Filled Circle and Filled Oval. 
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APPENDIX lWO: SLIDESHOWS 
To run the Slideshow included with The Graphics Studio, 
simply choose GSSHOW from the Launcher. The Slideshow 
will load and run automatically. To pause the S lid e s how, 
press S. To continue it, press N. To exit the Slideshow 
before it is finished, press X. 

Designing Your Own Slideshow 

To design a slides how , follow the steps outlined below: 

1. Copy the file GSSHOW from th~ Graphics Studio disk on to 
a blank formatted disk. 

2. Open a text file and name it SHOWSCRIPT. This text file 
will consist of commands and comments. Commands are 
directions to the computer on executing the slideshow. In 
this Appendix, commands will be typed in capital letters. 
This is not necessary in your script. Comments are 
reminders you may put in the text file to help you 
remember what you've asked the program to do. Comments 
must be enclosed by parentheses. 

3. Type in your commands and comments. The valid 
commands are listed below. Only the first letter of each 
command is needed in your script. Always press Return at 
the end of each line in the script. Always put a space 
between the command and its "argument". An argument 
modifies the command. 

Setting the Resolution 

The first command you will want to type in tells the 
program whfch resolution your pictures are in. If they 
are in Low-Res (320 x 200), type a 3 and press the RET URN 
key. If they are in Med-Res (640 x 200), type a 6 and then 
RETURN. Note: You may also type 320 for Low-Res or 640 
for Med-Res. 
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Loading a Picture 

To load and display a picture, use the Image command. The 
Image command may be typed as I, 1M, or IMAGE. After 
the Image command, type in the name of the picture you 
wish to load. If your pictur~s are in a subdireatory ,!as in 
the example below) be sure to include it in the filename. If 
the filename is missing, the previous picture will be 
redii>played. Note: There most be' a space between the 
Image command and the name of the. picture. Image is the 
command and the' name 'of the pifture is the argument. 
The slideshows capacity is 50 images. . Any-images above 50 
will be ignored when thy. sli~eshow is run. 

Examples: 

I \pictures\kittycat In ~his exam,P\e, Kittycat, is in the 
Pictures subdirectory. 

1M kittycat 

Displaying the Picture 

Once the picture, is loaded, you" have to .tell the computer 
how long to show it. To do this, use the Wait command 
which may be typed as W or WAIT. Then, add the 
argument which tells the computer how many seconds to 
wait. 

Example: 

WAIT 5 In this example, the picture will be displayed for 
5 seconds. 

The C 
cycling. 
examples 

command is used with a picture that c~o n t"a ins 
'Add C to the Wait "command line" as shown" in the 

below: 
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Examples: 

W C5 
WC 

In the first example, you are telling the computer to wait 
until the cycling has played through 5 times before 
moving on to the next command. If a number is not 
included, as in the second example (W C), the cycling will 
be shown once. If the Wait command is not properly used, 
the picture changes immediately. 

Transitions From One Picture To The Next 

When you move from one picture to the next, the screen 
will turn black for a few seconds before displaying the 
next picture. If you do not want this black screen 
included, use the F command, which may be typed as F or 
FX. This command goes directly after the Image command. 

Chan gin g Disks 

The Slideshow loads all· pictures into RAM before running 
the slideshow. If some of your pictures are on another 
disk, you can use the Volume command (V or VOL) to load 
them. During the slideshow loading process, you will 
prompted to insert the other disk. You may include 
subdirectories in the Volume command. 

Examples: 
Vol 
Vol 

/morepics 
/morepic s/anim als/ do g 

Repeating the Slideshow 

To play through 
Repeat command 

the slides how more than once, use 
(R or REP) at the end of the script. 
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argument defines the number of times the slideshow is 
repeated. 

Sample Script 

The following sample script is explained below: 

320 
IMAGE flower.scr (iris and orchids) 
WAIT C2 

VO /disk2/sub 

I haLscr 
FX 
W 10 

v /sample 
REP 10 

This script will display Low-Res pictures. The first picture 
is flower.scr (Note the comment in the parentheses.). It 
will be displayed until the cycling has been executed twice. 
At this point, hai.scr will be displayed for 10 seconds. Note 
that haLscr is loaded from the path disk2/sub and the 
screen will not be blanked before it is displayed. Also not 
that the original volume (Is ample) is reloaded. In this 
way, you will exit into the original path when the 
slideshow finishes. The slideshow is shown 10 times. 0 f 
course, it is only loaded once. 
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UPGRADE COUPON 

To receive information on low-cost upgrades and 
new products that will become available for use wi th 
The Graphics Studio, please fill out the form below 
and mail it to: 

Accolade IIGS Update 
20813 Stevens Creek Blvd. 
Cupertino, Ca. 95014 

Name ___________________________________ _ 
Address ________________________________ _ 
Ci ty ___________________ S ta te _____ Zi p _____ _ 
Phone Number ________________ Age ___ Sex __ 

By answering the questions below, you can help us 
make The Graphics Studio an even better product. 
Thank You. 

What I like most about The Graphics Studio: 

What I like least about The Graphics Studio: 

Features -I'd like to see added: 

# of Accolade products owned: ____ _ 
# of IIGS products owned: ______ _ 
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Free Rotation, 32 

Rotate Colors, 22, 25 

S 
Saving A Pi~ture, 39-40 

Save As, 39-40 
Save, 40 

Scale Area, 32-33 
Screen Format, 40 
Scrolling, 18, 44 
Select Font, 38 
Set Corner Roundness, 24 
Set Grid Spacing, 27 
Set Mirror Origin, 24 
Set Mirror Type, 24 
Set Outline Color, 24 
Setting A Color Range, 22 
Set Shadow, 23 
Shading Density, 13, 15 
Shadow, 21,22-23 
Slideshow, 51-54 
Status Line, 2, 3, 6 
Swap Colors, 31 

T 
Text, 37, 38 

Centering, 37 
Fonts, 38 
Replace, 37 
Transparent, 37 

Text Brush, 38 

Text Tools, 36-38 
Trashcan,5 
Transparent, 29, 32, 37 

U 
Unconnected Pixel Brush, 6, 15 
Undo,4,16 
Use Brushes, 24 
Use One Palette, 46 

V 
Vertical Line Fill, 16,25 

x 
X Color, 30-31 

Replace, 30 
Swap Colors, 31 
Pattern Edit, 35 

X Copy, 19 
XY Coordinates, 18, 26, 27 

Z 
Zoom, 25-26 
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Designed by Greg Hospelhorn 
Designed and Developed by Greg Hospelhorn and Audio-Light . 
Graphi~ by Peter Wickman and Richard Antaki 

Greg Hospelhom lives in San Francisco with his wife and four cats~ 
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Copyright ~ ~;; 
Copyright 1987 by Accolade. All rights reserved. No part of this publication may be 
reproduced, transcribed, copied, translated, or reduced to any electronic medium or machine 
readable form without prior written permission of Accolade, 20813. Stevens Creek Blvd. 
Cupertino, CA. 95014. 

Disclaimer . ( 
Accolade makes no representations or warranties with respect to this1publication or its 
contents and specifically disclaims any implied warranties of merchantability or fitness for 
any particular purpose In addition, Accolade reserves the right to revise this publication 
and to make changes from time to time in its contents without Obligation of Accolade to 
notify any person of such revisions or changes. 

'l'rademaJks 
The Graphics Studio is a trademark of Accolade. Apple IIGS is a trademark of Apple 
Computers, Inc. Deluxe Paint is a trademark of Electronic Arts. Paintworks Plus is a 
trademark of Activision. 

We understand your concerns about disk damage or failure. Because of this, each register~ 
owner of The Graphics Studio may purchase one backup copy for $15.00 In Canada, one 
backup copy may be purchased for $20.00 US currency. Calif. residents add 7% sales tax. 
Checks should be made out to Accolade Software. This copy is for backup purposes only 
and is not for resale. Your backup disk is covered by our limited warranty on disk media 
descnbed below. 



Limited Warranty for Disk Media 

Accolade warrants to the original purchaser of this computer software product that the 
recording medium on which the software programs are recorded will be free of defects in 
materials and workmanship for ninety days from the date of purchase. Defective media 
that has not been subjected to misuse, excessive wear, or damage due to carelessness and 
that is returned during that ninety day period will be replaced without charge. Following 
that initial ninety day warranty period, defective media will be replaced for a fee of $10.00. 
In Canada, you may obtain a replacement for $15 US currency. Calif. residents add 7% 
sales tax. Note: To speed processing, please return the disk only. The 
defective media should be returned to: 

Accolade 
20813 Stevens Creek Blvd., Cupertino, CA. 95014 

(408) 446-5757 

Software Copyright 
The enclosed software program is copyrighted. It is against the law to copy any portion 
of the software on disk, cassette tape, or another medium for any purpose. It is against the 
law to give away or resell copies of any part of this software. Any unauthorized 
distribution of this product deprives Accolade, Inc. and their authors of their deserved 
vrofits and royalties. Accolade, Inc. will seek full legal recourse against violators. 
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20813 Stevens Creek Blvd. 
Cupertino, Ca. 95014 

(408) 446-5757 


